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How to Find Photos and Artwork Online to
Spice Up Your Own Documents

Greeting cards, invitations, posters, newsletters,
and even some more-formal documents can all
benefit from pictures to make them more
attractive and attention-grabbing. The trouble is,
even if you’re a dab hand with a digital camera or
a graphics program, it’s not always possible to
create the picture you need.

Well, don’t even try! The Internet is teeming with free
pictures you can use, and in this article I’ll show you the
best places to find them.
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This article shows you how to:
• Save pictures you find on websites
• Find professional-quality photos you can use 

for free
• Find clip art pictures to use in informal documents

PCS_10_OCTOBER_2021_P410_14pp_mrg  29/07/2021  14:44  Page 27



P 410/2

Important: The Difference Between ‘Free’ and
‘Royalty Free’!

If you’ve ever tried to search for free pictures on the
Internet, you may have found it a rather confusing
business. A search for ‘free pictures’ or ‘free photos’ at a
good search engine will yield a large number of promising
links, but when you delve into many of those websites
you’ll find you’re expected to pay to use any pictures 
you like.

Many of the sites you find are actually offering ‘royalty
free’ images; in other words, you pay once for the right to
use the picture, and that entitles you to use it in 50,000
copies of a book or a million copies of a magazine without
having to pay for each individual copy used. For
commercial use these sites are a blessing, but they’re not
a good choice when you just want a picture to use in a
single birthday card or in six copies of a jumble sale poster!

Almost all of the websites I’ll point you to in this article
offer free – completely free – pictures that you can save to
your PC and use in almost any way you like. The only
limitations are that you’re not allowed to collect and
distribute them yourself (by setting up your own ‘free
pictures’ website, for example), and you’re not usually
allowed to use them for commercial purposes such as in
books and magazines or in other business-related
activities.

How to Save Pictures from a Website

The websites we’ll be visiting in this article work in
approximately the same way. On arrival you’ll find a list
of categories such as ‘People’, ‘Christmas’, ‘Buildings’,
‘Nature’, and so on. After clicking a suitable category,
you may arrive at a list of sub-categories to choose from;
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for example, the ‘People’ category may lead to a choice
of ‘Young People’, ‘Mature People’, ‘Couples’ and
‘Family’. After working your way through the categories
you’ll arrive at a page showing small copies of the
pictures in your chosen category.

In many cases you’ll find that there’s more than one
page of pictures in the category. Keep a lookout for a
‘Next’ link above or below those little pictures that
you can click to move to the next page.

When you see an image you like, just click it. That will
take you to a page showing a larger version of the picture
and, in most cases, some details about its creator.

This larger copy of the picture helps you decide whether
it really will fit the purpose you have in mind, but in most
cases it’s still not the full-sized copy, and it’s always best to
save the largest (and therefore most detailed) copy of a
picture you can find. Here, websites tend to work in
either of two ways:

• By clicking this larger copy of the image, you’ll be
whisked to a full-sized copy (perhaps in a new
browser tab).

• Beside or below the larger copy of the picture you’ll
see a ‘Download’ link or, perhaps, a collection of links
that lead to different sizes of picture. If so, click the
link to the largest size.

If it’s not obvious what you have to do, always try click-
ing the picture and seeing what happens. If it takes
you somewhere unexpected, you can click the ‘Back’
button at the top-left of your web browser’s window
to return to this page and have a closer look at it. If
nothing at all happens, you’re either already looking
at the largest-possible copy of the picture, or there’s a
link to a larger copy nearby that you haven’t spotted.
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After two or three clicks, you should be looking at a nice,
large copy of the picture you want, and all you need to
do from here is save it to your PC. Here’s how to do that:

1. Right-click somewhere on the picture.

2. On the context menu that appears, choose Save
image as.

3. Now you’ll see a Save As dialog of the sort you
always see whenever you want to save a file. As
usual, choose the folder in which you want to save
the picture, type a different name for it from the
name suggested if you want to, and then click Save.

4. Within a few seconds, the picture will be saved to
your PC, ready to use in the documents you create.

Alternatively, perhaps you don’t need to bother saving
the picture at all. If you have your word processor open
and you’re looking for a picture to include in the
document you’re working on, you can do this instead:

1. Having found a large copy of the picture you want
to use, right-click it and choose Copy image.

2. Switch back to your word processor, click at the point
where you want the picture to appear, and press
Ctrl+V to paste it there.
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That’s quicker and easier to do, but it means you can’t
easily use the same picture in other documents: you’d
have to find and reopen this document, right-click the
picture and choose Copy, then switch back to your new
document to paste it there.

Keep your pictures organised!

Before you start saving pictures from websites, it’s a
good idea to create a new folder inside your ‘Pictures’
folder to store them in. This keeps them separate from
your own photos, making them easier to find and
helping to avoid any confusion about where they came
from and how you can use them. 

Start File Explorer (by pressing Win+E) and make your
way to your Pictures folder. Right-click a blank space in
this folder and choose New > Folder. Give this new
folder an obvious name, such as ‘From Websites’, and
press Enter to confirm it. From now on, when you’re
saving a picture from a website by following the steps
above, make your way to this folder when you reach step
3 on the previous page.

The Top 6 Websites for Free Photos

If you’re looking for photos, as opposed to hand-drawn
artwork, one of the six top free-photos websites below
should lead you to exactly what you want.

Pexels
www.pexels.com
When you arrive at Pexels, you’ll see a large search box
in the middle of the page. Rather than looking through
categories of pictures, you search by keyword, so type
something descriptive such as ‘balloons’ or ‘cat’ and
press Enter. All your search results are gathered on a
single long page, so just scroll down until you find
something you like.
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When you find a suitable picture, click it and you’ll be
whisked to a page showing a larger (although probably
not yet full-size) version. If you’d like to save this
picture, do one of the following:

• Click the Free Downloadbutton in the top-right corn-
er of the page and choose where to save the picture.

• Click the picture once to display it at full size, then fol-
low either set of steps on page 4 to save it or copy it.

OpenPhoto
www.openphoto.net
At OpenPhoto, begin by clicking the Browse link near
the top of the page. This takes you to a collection of
categories such as Animals, Food, Nature and People.
Click a suitable category and you’ll arrive at the first of
several pages of photos in that category. Near the top
of the page, below the name of the category you
clicked, you may see several sub-categories listed, and
you could click one of those.

If you find a photo that looks promising, click it and
you’ll arrive at a new page that shows it at a larger size
(although not usually full size). If you’d like to use this
picture, click the Download link to the bottom-left of
the picture. This opens the full-size picture in a new
browser tab, and you can follow either set of steps on
page 4 to save or copy it.

StockVault
www.stockvault.net
Click the word Categories at the top of the page and
then choose a suitable category from the panel that
opens. This leads you to the first of several pages of
photos in that category.

Stockvault has an affiliation with another photo site
named Shutterstock which offers royalty-based (not
free) photos; you’ll find sections at the top of some

32 October 2021

Choose a 
picture category

Pictures: Find Free Images Online 

PCS_10_OCTOBER_2021_P410_14pp_mrg  29/07/2021  14:44  Page 32



P 410/7

pages showing examples of Shutterstock’s photos.
Since it’s annoying to find the perfect picture and
then realise you have to pay for it, try to avoid clicking
the photos in these sections! 

Click a picture to see it at a larger size. It’s probably not
full-size, although you may feel it’s large enough to use,
in which case you could use one of the methods on
page 4 to save or copy it. To ensure you’re getting the
full-size picture, click the Free Download button to the
right of the picture to save it. 

Wikimedia Commons
commons.wikimedia.org/wiki
This oddly-named site is one of the best and most-
famous repositories of free media files, with over 70
million pictures, audio files and videos at the time of
writing. In the ‘Content’ box at the right of the page
you choose a fairly general category, and then begin
digging through ever-more-specific categories to find
the type of pictures you’re looking for.

When you click a small version of a picture, you’ll arrive
at a much larger one. From here, click that picture to
see the full-sized version which you can then save to
your PC by following the steps given on page 4. 

FreeImages
www.freeimages.com
This is another site that uses keywords rather than
categories, so you begin by typing a word or two into
the search box on the home page. This leads you to the
first of several pages of results.

Like StockVault above, FreeImages also affiliates with
a company offering non-free pictures, and you’ll see a
section containing some of those at the top of each
page. Ignore those and look at the collection of free
pictures below.
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Click any picture to see it at a larger size. If you’d like to
use this picture, click the Download button below it: this
offers you a choice of sizes to download, each with its
own ‘Download’ button, and I recommend choosing the
largest (noted as ‘Full’).

Pixabay
www.pixabay.com
Along with photos, Pixabay also offers ‘illustrations’ –
graphical artwork – and a search here shows both in its
search results. When you arrive, just type a keyword or
two into the large search box and press Enter, and
you’ll be taken to the first page of results.

As always, click a picture to see a larger (although not
full-size) copy of it on the next page. If you’d like to use
this image, begin by clicking the Free Download button
to its right. On the menu that appears, click the size you
want: as usual, I’d suggest choosing the largest size for
best quality, although if you know you’ll be using the
picture at a comparatively small size you might choose
something smaller. Now do either of the following:

• To download and save the image, click the Download
button.

• To see the image at full size, click the View button
and then click the picture when it appears. From
here, you can use either of the methods on page 4 to
download the picture or copy-and-paste it into a
document.

3 Sites to Find Hand-drawn Clip Art

The term ‘clip art’ refers to hand-drawn (often rather
cartoon-like) artwork, and these are the kinds of
pictures you’d probably prefer to use in informal
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projects such as cards, invitations and posters. Here are
three of the best free clip art sites to visit.

Daily Clip Art
www.dailyclipart.net
The majority of clip art websites concentrate on quantity
rather than quality, but Daily Clip Art certainly doesn’t.
Many of the images you’ll find on this comparatively-
small site are superb, so always make this your first port
of call. After selecting a category from the front page,
you’ll generally find all the images in that category on
the single page you reach next. However, look out for a
small Previous Entries link near the bottom of the page
which (if it’s there) will lead to another page of images
in your chosen category.

Although the examples you see on these pages are large
and clear, they’re not usually full-sized, so always click
any image you like and then save the full-sized picture
that opens in a new browser tab, closing that tab
afterwards.

Free-Graphics.com
www.free-graphics.com
This website claims to have over 30,000 clip art images,
and they’re neatly organised into categories you’ll find
at the left of the page. Some of these lead to further
categories. Don’t overlook the ‘Clip Art’ category in this
list: this presents a large collection of sub-categories
which are where you’ll find most of those 30,000 images!

As usual, click any small picture to see it at full size, and
follow the steps on page 4 to save that large picture to
your PC.

ClipSafari
www.clipsafari.com
At this website you’ll find over 100,000 clip art images,
most of which are superb quality. Unusually, these
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images can be used absolutely anywhere for free,
including for commercial purposes. When you arrive at
the site, you can either search for a picture by typing
keywords, or you can scroll to the bottom of the page
and click one of the ‘popular tags’ to see pictures
tagged with that word.

Click any picture to see it at full size on a new page.
From here, you can follow either set of steps on page 4
to save it or copy it, or you can click the Download as
PNG File button.

Search Through Billions of Pictures
at Google

If you need to find pictures for purely-personal use, one
of the best places to look is the famous Google search
engine. Not only does Google index web pages, but the
pictures it finds on them, and the sheer size of the
World Wide Web means that billions of pictures are just
a few clicks away.

To search for images at Google, follow these steps:

1. Either type images.google.com into your browser’s
address box and press Enter, or visit the usual
www.google.com site and click the word Images in
the top-right corner.

2. In Google’s search box, type a word or two to
describe the type of picture you want (such as
‘birthday cake’ or ‘flowers’) and press Enter.

3. Now you’ll reach the search results, which is a never-
ending page: keep scrolling downwards and ever
more pictures are loaded. Each picture is captioned
with the title of the web page it was found on and
the URL of that page’s website.

36 October 2021

Pictures: Find Free Images Online 

Google indexes
pictures as well as

web pages

Keep scrolling to
see more pictures

PCS_10_OCTOBER_2021_P410_14pp_mrg  29/07/2021  14:44  Page 36



P 410/11

4. When you come across a picture that takes your
fancy, click it. A panel will appear at the right of the
page showing that picture at a larger size. You’ll also
see some details and quotes from the web page
containing the picture and, below that, some
‘Related images’ which you may like better – if so,
just click one.

5. If you like the look of the picture shown in that side
panel and you’d like to use it, click it. This opens a
new browser tab which takes you to the web page
where Google found that image. (Of course, you
may have to scroll around that page a little to find
it.) If you want to use the picture you’ve found,
follow either set of steps on page 4 to download it
or copy-and-paste it into a document.

As Google notes in that side panel, the picture may be
subject to copyright – in fact, it almost certainly is. No-
one is likely to object to your using their image in a
greeting card or on a poster for your village jumble
sale (assuming they knew you were doing so!), but it’s
wise to ask permission before using the picture for
anything more commercial in nature. 
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Free Images from Microsoft’s Online Gallery

If you’re working on a document in Microsoft Word, you
have access to a huge gallery of free pictures –
photographs and clip art. Just click at the point in your
document where you want to insert a picture and follow
the appropriate steps below for your version of Word.

Word 2019:

1. Switch to the Insert tab on the Ribbon, and in the
‘Illustrations’ group click the Online Pictures button.

2. In the window that opens, you’ll see a ‘Search Bing’
box at the top and, below it, a collection of
categories such as ‘Airplane’, ‘Animals’, ‘Apple’. If
one of those categories seems to fit the bill, click it to
see the pictures it contains. Otherwise, click in the
Search Bing box and type a word or two that
describes the picture you want, such as ‘balloons’ or
‘globe’ or ‘birthday cake’, then press Enter to search
for pictures.
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3. The window changes to show all the pictures found
in your search (or included in the category you
clicked). At the moment you’re seeing all types of
pictures – clip art, photographs and simple line
drawings. If you want to see only clip art pictures, or
only photographs, click the little filter icon to the top-
left of the pictures and choose your preferred picture
type from the menu to hide the other types.

If you want to fine-tune the results further, you can
click the filter icon again to reopen the menu and
choose other options. Under Size you can specify a
picture size ranging from Small to Extra Large;
under Layout you can pick Square, Wide or Tall
pictures; and under Color you can specify that you
want colour or black-and-white pictures, or click a
colour swatch to see pictures that predominantly
feature that colour.

5. If you find a picture you want to use in your
document, just click it once to select it and then click
the Insert button at the bottom of the window. The
window closes and the picture appears in your
document. (If you didn’t find a suitable picture, type
something different in the search box to search
again, or click the arrow to the left of the search box
to go back to the categories.) 

Word 2016 or 2013:

1. Switch to the Insert tab on the Ribbon, and in the
‘Illustrations’ group click the Online Pictures button.

2. In the window that opens, click in the search box bes-
ide the words ‘Bing Image Search’ and type a word or
two that describes the picture you want, such as ‘bal-
loons’ or ‘globe’ or ‘birthday cake’, then press Enter.

3. The window changes to show the results of your
search. At the moment you’re seeing all the possible
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types of pictures – clip art, photographs and simple
line drawings. If you want to see only one particular
type of picture, open the Type menu at the top-left
of the pictures and choose your preferred type.

If you choose to, you can fine-tune the results
further using the other two menus. The Size menu
lets you specify the size of the picture, ranging
from Small to Extra Large. The Colour menu lets
you choose between colour and black-and-white
pictures, or you can click a colour swatch to see
pictures that predominantly feature that colour.

4. If you find a picture you want to use in your
document, just click it once to select it and then click
the Insert button at the bottom of the window. The
window closes and the picture appears in your
document. (If you didn’t find a suitable picture, you
can type something different in the search box to
search again.)
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